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| 1. ORDERING GUIDE I

Configure a model number in this format: LT20DCV1, CBL04

— Transmitter Type

LT......4-20 mA, 0-20 mA, 0-10V,
or -10V to +10V isolated analog
output, isolated RS232/RS485
serial data output, two 120 mA
solid state relays, and isolated
transducer excitation output.

LTE.... 4-20mA, 0-20 mA, 0-10V
or -10V to +10V isolated analog
output, isolated Ethernet output,
two 120 mA solid state relays,
and isolated transducer excita-
tion output.

Main Board

2., Standard main board
4. Extended main board
Note: Extended main board

adds rate of change and custom
curve linearization. Not applic-
able to temperature.

Power

0......85-264 Vac or 90-300 Vdc
1o 12-32 Vac or 10-48 Vdc

Input Type

DC Volts

DCVA......c.oovv 200.00 mV
DCV2.........ccoovvee 2.0000 V
DCV3......ccoveeeee 20.000 V
DCV4............cocevee 200.00 V
DCVS™.....ccoveveeee 600.0 V
DCV6.......c.cooevvee 300.0V
DC Amperes
DCAT.........coceveee 2.0000 mA
DCA2....................... 20.000 mA
DCAS........cccoeeveee. 200.00 mA
DCA4...........c.ocoveee. 5.000 A

RMS Volts

RMVA................... 200.00 mV
RMV2........cccocooe 2.0000V
RMV3.......ccocove 20.000 V
RMV4....................... 200.00 V
RMVS* ..o 600.0V
RMV6...............o....... 300.0V
RMS Amperes
RMAT.................. 2.0000 mA
RMA2................ 20.000 mA
RMA3..................... 200.00 mA
RMA4......................... 5.000 A

* Range not ETL certified

Process & Ratio Signals
4-20 mA, 0-10V, etc.

P.....4-20 mA in = 4-20 mA out
P1................ Custom Scaling

Specify min input and output,
max input and output.

Load Cell & Strain Gauge

4- or 6-wire ratio. Full scale
ranges from 20 to 500 mV.

WM1........... -99,999 to +99,999

Specify min input and output,
max input & output.

RTD Temperature

Pt100, P385C..... -202 to 850°C
Pt100, P385F ....-331 to 1562°F
Pt100, P392C.... .-202 to 850°C
Pt100, P392F ....-331 to 1562°F
Ni120, 672C........ -80 10 260°C
Ni120, 672F ........ -112 to 500°F
Cu10, 427C ......... ~97 t0 260°C
Cu10, 427F ......... -143 to 500°F

Thermocouple Temperature

JC o -210 to 760°C
JFoo, -347 to 1400°F
KC..ooveee -244 t0 1372°C
KF..oooveie -408 to 2501°F
TC .o, -257 10 400°C
TF o, -430 to 752°F
EC.....coeevee. -240 to 1000°C
EF .....cc.ocve. -400 to 1830°F
NC....o.eee -245 10 1300°C
NF. .o -410 to 2370°F
SCa -46 t0 1768°C
SF oo -51 to 3214°F
RC.....ovee -45 10 1768°C
RF...covee -49 to 3213°F
Resistance

RO....... 0-2 ohms (fixed range)
Rl.. 0-20 ohms
R2......ooei 0-200 ohms
R3.......................0-2 kohms
R4.......ccceevne 0-20 kohms
RS 0-200 kohms

R6......0-2 Mohms (fixed range)

ACCESSORIES
CBLO4....... RS232 cable, trans-
mitter to computer

CBLO2....... USB to DB9 adapter
cable
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| 3. PRODUCT OVERVIEW I

This manual covers LT Series DIN rail transmitters with isolated analog and RS232/RS485 outputs,
dual relays, and an analog input signal conditioner. A separate manual covers LTE Series DIN rail
transmitters with isolated 4-20 mA and Ethernet outputs, dual relays, and an analog input signal
conditioner.

LT Series transmitters duplicate the signal conditioning and signal processing features of their
1/8 DIN panel-mounted digital panel meter counterparts for exceptional accuracy at high read rate.
A wide range of analog signal sources are accommodated by five analog signal conditioners:

e DC input for volts, amps, process signals (e.g., 4-20 mA), and strain gauges. Most sensitive
full-scale input range of 200 mV. Built-in 5A current shunt.

e AC rms input for volts and amps. Can be AC or DC coupled. Built-in 5A current shunt.

e Load cell or microvolt input with selectable full-scale input ranges from 20 mV to 500 mV.

e Thermocouple temperature input for seven thermocouple types.

e RTD temperature or Ohms input for Pt100, Ni120 or Cu10 RTDs, or 20Q-200 kQ resistance.

A 4-20 mA, 0-20 mA, 0-10V, or -10V to +10V isolated analog output is standard. This output is
generated by an ultra-linear 16-bit digital-to-analog converter which tracks an internal linearized
digital reading.

Isolated serial communications are standard. The transmitter serial port is default jumpered for
RS232 or full-duplex RS485 (same jumper settings). Half-duplex RS485 is also selectable either
via internal or external jumpers. Three serial protocols are software selectable: Modbus RTU,
Modbus ASCIl and Custom ASCIl. Modbus allows devices by different manufacturers to be
addressed on the same data line. The simpler Custom ASCII protocol is recommended when there
are no devices by other manufacturers on the data line.

An isolated transducer excitation output is standard, in DC, process and load cell input models.
Three output levels are jumper selectable: 5V at 100 mA, 10V at 120 mA, or 24V at 50 mA. The
factory default setting is 10V and can power up to four 350 ohm load cells in parallel.

Two isolated solid state relays are standard. These are rated 120 mA at 140 Vac or 180 Vdc.

Isolation to 250V rms is provided for power, signal input, analog output, relay outputs, and com-
munications. Isolation adds safety and avoids possible ground loops. The transducer excitation
output is isolated to +50V from signal ground.

Internal jumpers are used to select the signal range, analog output type, communication type, and
excitation level. The transmitter configuration is specified by the model number on the transmitter
label. A user can reconfigure the transmitter by opening the case and moving jumpers.

Transmitter scaling is via serial connection to a PC using MS Windows based Instrument Setup
Software, which can be downloaded at no charge. The required transmitter-to-PC interface cable
is available for purchase.

-4 -



| 4. RECEIVING & UNPACKING YOUR TRANSMITTER I

Your transmitter was carefully tested and inspected prior to shipment. Should the transmitter be
damaged in shipment, notify the freight carrier immediately. In the event the transmitter is not
configured as ordered or is inoperable, return it to the place of purchase for repair or replacement.
Please include a detailed description of the problem.

| 5. SAFETY CONSIDERATIONS I

A Warnings: Use of this transmitter in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Do not attempt to operate if the unit shows
visible damage.

e This unit may be from 85-264 Vac or with the worldwide voltage power supply option, or from
12-32 Vac or 10-48 Vdc with the low voltage power supply option. Verify that the proper
power option is installed for the power to be used.

e The 85-264 Vac power connector (P1 Pins 1-3) is colored Green to differentiate it from other
input and output connectors. The 12-32 Vac or 10-48 VVdc power connector is colored Black.
This transmitter has no power switch. It will be in operation as soon as power is applied.

e The analog output is sourcing. Do not connect the 4-20 mA analog output to a load designed
to apply 24 Vdc to a two-wire transmitter. Applying 24 Vdc will burn out the main board.

e To avoid dangers of electrocution and/or short circuit, do not attempt to open the case while
the unit is under power.

e To prevent an electrical or fire hazard, do not expose the transmitter to excessive moisture.
Do not operate the transmitter in the presence of flammable gases or fumes, as such an
environment constitutes an explosion hazard.

Symbols applicable to this product:

A Caution (refer to accompanying documents)

A Caution, risk of electric shock.
0 Equipment protected throughout by double

Earth (ground) terminal.

Both direct and alternating current.

S iIF

ETL Mark. Indicates that product

insulation or reinforced insulation. ) .
CE Mark. Indicates that product meets ¢ el} v confo_rms to UL 5td. 61010-1 and is
: imerree Certified to CAN/USA Std. C22.2 No.
€ EU safety, health and environmental 400047 61010-1

requirements.

Operating environment:

Transmitter Class Il (double insulated) equipment designed for use in Pollution degree 2.
-5-



| 6. TRANSMITTER FIELD WIRING I

@
) Power GND, signal input GND,
analog output GND and comm.

See manual for different 1 GND are mutually isolated to
input signal types. 2 ; 250 Vac. Control input GND is
Pe Signal Signal same as signal input GND
See section 14 for main 3 g‘x%iltt:-ztion conditioner 'gnatiney )
board jumper settings g output board For RS232, connect P2-3 to
P2-2.
6
Control input2 1 RS485 RS232
Control input1 2 PS5 Control 6 N/C T
Control input GND 3 inputs 1 & 2 i 2_?;(( E)é
Analog ret. 0-10V or 4-20 mA 1 P2 Serial
Analog output + 2 P4 Analog data l/O g gclj?n)lm o ggnr;rr: g:B :I_
Analog return -10V to +10V 3 output
11 BTX N/C
AT P3 Solid
AL2 2 ol P1 Power |@ | 3 Power GND
AL1T 3 state relays input 2 AC neutral or -DC
AL1 4 1 AC high or +DC
7l 6 TX 1Sk O] 6 N/IC
D 5 RX 51957 D 5 ARX, RX-, RXDO —] ATX
| 4 NC He L ] 4 ATX, TX-, TXDO ARX
W 3 GND :l D 3 GND GND
| 2 BRX K 2 BRX, RX+, RXD1 BTX
94 1 N/IC DB9 connector N 1 BTX, TX+, TXD1 BRX
to PC
Transmitter (rear view) Transmitter Master
RS$232 wiring RS$485 wiring, full duplex
| 6 N/C | 6 N/C
| 5 ARX/ATX ——ATX/ARX | 5 ARX ATX/ARX
D 4 N/C | 4 ATX —
| 3 GND —— GND ] 3 GND —— GND
W 2 BRX/BTX —BTX/BRX I 2 BRX BTX/BRX
21 1 N/C 28 1 BTX —
Transmitter Master Transmitter Master
RS$485 wiring, half duplex RS$485 wiring, half duplex
with internal jumpers. with external jumpers.



P6 - SIGNAL INPUT DETAIL

DC & Externally Powered Process

- Excitation 1

+ Excitation 2
- Signal input 3 -DC
+ Signal input 4 .: +DC

2-Wire Process Transmitter

- Excitation 1
+ Excitation 2
- Signal input 3
+ Signal input 4

==

DC Ratio

Bridge Potentiometer

- Excitation 1
+ Excitation 2
- Signal input 3
+ Signal input 4

AC & AC+DC True RMS

Voltage Signal In 1
NC 2
Signal Return 3

Current or Low 4
Voltage Signal In

AC neutral
2,20, 200 mA
5A, 0.2VA

Thermocouple

NC 1
NC 2

=

- Signal input 3
+ Signal input 4

MOUNTING FOR COOLING

Mount transmitters with ventilation holes at top

and bottom. Leave minimum of 6 mm (1/4")
between transmitters, or force air with a fan.

: \ RTD or Resistance - 3 Wire

2, 20, 200, 600V

Load Cell

- Excitation 1
-Sense 2

- Signal 3

+ Signal 4
5

6

+ Excitation
+ Sense

For 4-wire load cell connection, jumper
Pin1 to Pin 2, and Pin 5 to Pin 6.

RTD or Resistance - 2 Wire

- Excitation 1
+ Excitation 2
- Signal input 3
+ Signal input 4

- Excitation 1
+ Excitation 2
- Signal input 3
+ Signal input 4

— =

RTD or Resistance - 4 Wire

]

P4 - ANALOG OUTPUT DETAIL
Unipolar Output (0-10V, 4-20 mA)

- Excitation 1
+ Excitation 2
- Signal input 3
+ Signal input 4

i

Analog return 1 [ E]
Analog output 2 | @
3 |@
Bipolar Output (-10V to +10V)
1 @
Analog output 2 | @ |:]
Analog return 3 [

500 Ohms max load for 4-20 mA,
5 kOhms min for 0-10V or -10V to +10V

Analog output is sourcing. Do not apply
external voltage. External 24 VVdc power
will damage the analog output section.



| /. PROGRAMMING YOUR TRANSMITTER I

Our transmitters are easily programmed using a PC and Instrument Setup (IS) Software, which
runs under MS Windows and provides a graphical user interface. This software allows
uploading, editing, downloading and saving of setup data, execution of commands under
computer control, listing, plotting and graphing of data, and computer prompted calibration.

USING INSTRUMENT SETUP SOFTWARE

As a first step, set User Account Control (UAC) of your version of Windows to “Never notify" so
that Instrument Setup Software can create directories. Use Google for instructions. Power
down and restart your computer for the UAC change to take effect.

| 6 TX i gg g
RS232 cable with rear view of DB9 © 1 5 RX 2150)7
connector to PC % g cN;ﬁD 10

D | 2 BRX 1

D1 1 neC

Use a 3-wire RS232 cable (P/N CBL04) to connect your transmitter to the COM port of your PC.
Download the file ISx_x_x.exe from our website and double-click on the file name. Click on
“Install Instrument Setup Software” and follow the prompts.

To launch IS software, press on Start => Programs => 1S2 => Instrument Setup or on the
desktop shortcut that you may have created. Following a brief splash screen, the
Communications Setup screen below will appear.

=, Communications Setup BB

Communications

Help | ~ Protocol

Parity
@® Custom ASCII @® None
C Modbus RTU
C Modbus ASCII

~Device Type
C Panel Meter L, LW (Display)

@® Transmitter LT (No Display)
C Transmitter LTE (No Display)

RS 485
| R5232 Full
Duplex

RS485
Half
Duplex

Communications Type ? None Ethernet




In the Communications Setup screen, select the “Custom ASCII” as the protocol, as this is the
factory default setting. Select “Transmitter LT” as the Device Type and RS232 the Communi-
cations Type. This will take you to the Establish Communications screen.

% Establish Communications

- Com Ports ~Baud Rate
Establish |
® Com 1 O 300

C Com 2 O 600

O Com3 O 1200
O Com 4 O 2400
O Com5 O 4800
O Com 6 ® 9600
© Com7 ©19200

C Com8 138400 El;l:le Back |
O Com 9
—~Other Com Pnrt] Quit

Communication Established on Com 1, Baud = 9600, Custom ASCIT Address = 1, Parity = INone |

Meter Type |DPI\I Transmitter Revision 54

In the Establish Communications screen, select your Com Port and 9600 and the Baud Rate.
You will be able to change your protocol and baud rate later under the Communication setup
tab. Click on Establish, and the two fields at the bottom of the screen should turn green. Click
on the Main Menu button.

From the Main Menu, click on DPM => Get Setup to retrieve (or get) the existing setup data
from your DPM transmitter. Click on View => Setup to bring up screens which allow you to
easily edit the setup file using pull-down menus and other selection tools. You can download
(or put) your edited file into the transmitter by clicking on DPM => Put Setup. You can save
your setup file to disk by clicking on File => Save Setup and retrieve a previously saved file from
disk by click on File => Open.

The best way to learn IS software is to experiment with it.

For context-sensitive help for any data entry field under any tab, select that field and press the
F1 key.



Input+DispIayT Scaling T Filter T Relay AIalmsTEummunicatiur]/ Analog Out ]
C BASIC . Sig Cond Option
Option
(® EXTENDED Boards IDC "I
-Signal Input
r Mode Range ———  Custom Curve Rate ——— ~ 50/60 Hz Line Freq
[pcv =] “ 0.3V | ||| pisabled =] “Disabled | ﬁﬁouz j—‘
- Display
r Resolution r Decimal Point Auto Tare
[+.5Digits =] {ddd . dd j—‘“nisabled |
~Control Inputs
Control Input 1 ------------ Control Input 2 -------------—-- Both Ctrl 1,2
|: Meter Reset Meter Hold Meter Reset j
| Meter Reset Meter Hold Meter Reset A
Function Reset Peak Display Meter Reset
Meter Hold Tare Meter Reset
Peak Display Tare Function Reset
Tare Meter Reset HMeter Reset
DP2 (Neither = DP1) DP3 (Both = DP4) Hone
DP3 (Neither = DP2) DP4 (Both = DP5) None ~

To get to the Input+Display tab, click on DPM => Get Setup to retrieve the current setup
information from your DPM transmitter, then on View => Setup. Use the Input+Display screen
to set up Signal Input, Display, and Control Inputs. The software reads the signal conditioner
type, but not the range, which is set by jumpers. The “50/60 Hz Line Freq” selection is used to
optimize filtering for 50 or 60 Hz electrical noise.

For ratiometric operation with a DC signal conditioner, set the Signal Input Mode to Ratio. In
this mode, the transmitter tracks a ratio of the applied excitation voltage and is unaffected by
changes in the excitation voltage. This capability is used for resistive bridge sensors and
voltage dividers, such as potentiometers which track wiper position.

Clicking on the Control Inputs field opens a pull-down menu which allows selection of the roles
of Control Input 1, Control Input 2, and simultaneous Control Inputs 1 and 2. For example, with
a DC signal conditioner and the highlighted selection, grounding Control Input 1 places the
transmitter on Hold, grounding Control Input 2 causes the Peak reading to be transmitted, and
grounding both Control Inputs 1 and 2 causes a Function Reset, which resets Peak, Valley and
latched alarms. Note that the roles of the Control Inputs vary with the type of signal conditioner.
Only the applicable roles will be displayed.

-10 -



Input+DispIay| Scaling T Filter T Relay AIarmsTEnmmunicatian Analog Out 1

-Scaling
—Scale - Offsek
O Scale, Dfset = | +1.0000 ‘ | +000.00 |
() Coordinates > |rLowIn rLow Read High In High Read
® Reading Coord> | +.00000 ‘ ‘ +000.00 | “ +.20000 | “ +200.00
{~ Start Low In (" Start High In
i~ Capture Low In = Capture High In

Enter Dec ¥alue

o jo 0.0 o |

CE =N

Click on the Scaling tab to scale your transmitter. You will be given the choice of three scaling
methods for inputs other than temperature: 1) Scale and Offset method, 2) Coordinates of 2
points method where (Low In, Low Read) and (High In, High Read) data points are entered
numerically, and 3) Reading Coordinates of 2 points method, which uses actual readings.

InputsDisplay|  Scaling |  Fier | Relay Alarms | Communication] Analog Out |
|'F1“¢l'

"Time Constant "Threshnld

Peak/Valley ¥alue
ILow Adaptive j [

Automatic ﬂ Filtered :J

Click on the Filter tab to set to set up filtering for your readings. The filter time constant can be
automatic, be specified in seconds, or be turned off. The adaptive threshold modifies the time
constant in response to noise. A low adaptive threshold is recommended for normal low noise.
A high adaptive threshold is recommended for high noise environments.

-11 -



Inpul+DispIa}lT Scaling T Filter T Relay Alarms T CummunicatinnT Analog Out ]

rAlarm 1—— rAlarm 2——
r Setpoint 1 r Setpoint 2

[ +o10000. | [ +020000. |

r Deviation 1 r Deviation 2

[ +o00000. | [ +o00000. |
rAlarm 1 Source — rAlarm 2 Source —
réAlarm 1 State — rAlaym 2 State —
rRelayl Alrm Staie r Relay2 Alrm Staie
rDeviation 1 Type — rDeviation 2 Type —
rAlarm 1 Type — rAlarm 2 Type
Alarms 1,2 No. Rdgs to Alarm
== gl

Click on the Relay Alarms tab to set up your transmitter’s two solid state relays, which are
standard. For detailed help on any data entry field under, select that field and press the F1 key.

Inpul+DispIa}lT Scaling T Filter tion| Analog Out ]

~Serial Communications

r Baud Rate Address r Ouiput Items ——— — Ountput Filter r Output Rate —
| 9600 = “ 1 =) ||| sem 1 = “Un.ﬁ.ltemd ||| |Read Rate  ~|
- Oulput Mode —— [ Incl Alarm Data [ CRLH————— ~FullHalf Duplex
Command 7| |/ Include LF |stEndoran 7] m

r Serial Protocel

[Cotom ASCH 7]

r Recognition Char — Transmission Chars

it~ 1 [ et crr] |

Click on the Communication tab to view the communication parameters that you used to
establish default communications with your transmitter. You can reselect Baud Rate, Device
Address, Serial Protocol, and Full or Half Duplex, even though you may have selected different
values to establish initial communications with your PC. Select Full Duplex, not Half Duplex,
even if you are using half-duplex RS485 wiring.

-12 -



Input+Display Scaling Filter Relay Alarms | Communication|  Analog Out
g

Analog Output

Lo Range Reading Range ———— — Hi Range Reading
“mnnnnn. | —‘“4_QUMCMM - ’7|+1I]I]I]I]I]. | —‘

Source

“ Ttem 1 |

Enter. decimal ¥alue

*oooppp.

“o o |

Click on the Analog Out tab to scale your analog output, which is standard. Under Range, select
0-20 mA current, 4-20 mA current, 0-10V voltage, or -10V to +10V voltage. Type in your Lo
Range Reading and Hi Range reading. These will create the two endpoints of your analog
output range.

For detailed help on any data entry field, select that field and press the F1 key.

-13 -



ADDITIONAL INSTRUMENT SETUP PROGRAM FEATURES

e The Commands pull-down menu allows you to execute certain functions by using your
computer mouse. This menu will be grayed out unless a Get Setup has been executed.

e The Readings pull-down menu provides three formats to display input data on your PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy on your PC printer.

- List presents the latest internal readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Printfor a hardcopy.

- Plot generates a plot of internal readings vs. time in seconds. It effectively turns the
transmitter-PC combination into a printing digital oscilloscope.

- Graph generates a histogram, where the horizontal axis is the internal reading, and the
vertical axis is the number of occurrences of readings. The display continually resizes itself
as the number of readings increases.

-14 -
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Print | Save | Pause | Continue | New Scalel End
Graph

e The Jumpers pull-down menu shows jumper positions for the selected signal conditioner
boards and the main board, duplicating information in this manual.

DC Signal Conditioner. Jumpers

1- |:| 1 - Excitation
|:| 2 + Excitation
|:| 3 - Signal In

.‘A D 4 + Signal In
(R
b. *nc’ .’
12 al * 59
) . *h
DC Signal Conditioner
Yoltage Current
Input Range Jumper Positions Input Range Jumper Positions
200 m¥ E.b 2 mA D.h.b
2V E.a 20 mA C.h.b
20¥ F.g.b 200 mA B.h.b
200% F.g.a A A h b
660 W F.h. a
Motes: 1. Click on Jumpers/Power Supply to select jumpers for 5, 10 or 24¥ Excitation.
2. Upper case letter positions require 5mm(. 2in] jumpers. lower case 2.5mm{0_1in)
jumpers.
3. Store spare jumpers on single unused jumper posts NOT associated with upper
case letters.
Print 0K

-15 -



| 8. OPENING YOUR TRANSMITTER CASE I

WHEN TO CHANGE JUMPERS

Your transmitter case does not need to be opened if jumpers have already been set by your
distributor. Otherwise you will need to open the case and either set jumpers or verify that the
factory default jumpers positions will meet your needs. Note that while Instrument Setup
Software senses the circuit board type, it does not sense jumper settings, and the correspond-
ing information has to be entered manually. Jumpers are used for the following:

1) On the signal conditioner board to set the signal type (e.g., voltage or current) and the
range. For details, please see the next five sections of this manual. Note that all ranges of
all signal conditioner boards are factory calibrated, with calibration factors stored in
EPROM on the board.

2) On the main board to set the serial communication signal (RS232 or RS485), termination
resistor for long cable runs, analog output signal (current or voltage), and sensor excita-
tion output (5V, 10V or 24V). Default factory settings are current output, RS232, no
termination resistor, and 10V excitation.

HOW TO OPEN & CLOSE THE CASE

The two clamshell halves of the case are held together with a bolt and a nut at each of the four
corners. Use a Phillips screwdriver to remove the four bolts. The nut will then drop off, and the
clamshell halves will separate. When closing the case, make sure that the ventilation grills are
properly aligned.

C Caution: The nuts at each corner are not captive and are black. Take precautions
so that the nuts do not get lost.

-16 -



9. DC SIGNAL CONDITIONER BOARD (DC, PROCESS, RATIO)

The DC volts, DC amps and process transmitters utilize the DC signal conditioner board, which
needs to be configured via jumpers for the desired voltage or current range. All signal ranges
are factory calibrated with calibration factors stored in EEPROM on the signal conditioner
board. Instrument Setup Software recognizes the board and brings up the appropriate menu
items for it; however, it does not recognize the jumper settings. The excitation output can be
set to 5V @ 100 mA, 10V @ 120 mA, or 24V @ 50 mA via main board jumper settings. Please
see Section 14 of this manual.

Board Revisions Q and R

Voltage Ranges Jumpers

FS Input E1 E2 E3
+200.00 mV A f b
+2.0000 V A f a
+20.000 V B h b
+200.00 V B h a
+300.0V B g a
+600.0V (not ETL) B g a
Current Ranges Jumpers

FS Input E1 E2 E3
+2.0000 mA A e,J b
+20.000 mA A d, g b
+200.00 mA A C, g b
+5.000 A A a, b, g b

1. Use 5 mm (0.2") jumpers for locations E1 designated by a capital letter.
2. Use 2.5 mm (0.1") jumpers for locations E2 and E3 designated by a lower case letter.
3. Store spare jumpers on an unused jumper post not associated with a capital letter.

For process & DC ratio, three scaling methods can be selected in Instrument Setup Software:
1) Scale and offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2 points, which
uses actual signals. Only menu items applicable to the selected method are presented. Full-
scale ranges are +20000 counts. For resolution purposes, the 300V and 600V ranges are 2000V
(100 mV/count), and the 5A range is 20A (1 mA/count).

For use with load cells, select 5V or 10V excitation, set Mode to Ratio, and set Range to 0.2V.
The transmitter will then use the excitation voltage as the reference for A-to-D conversion,
thereby correcting for any variations in excitation voltage. The excitation can drive four 350-
ohm load cells in parallel.
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For use with potentiometers, where excitation and signal share the same ground, select 5V
(not 10V) excitation, set Mode to Ratio, and set Range to 0.2V. Again, the meter will use the
excitation voltage as the reference for A-to-D conversion. Often used for length measurement.

Example: Transmit the digital reading in amps and as 4-20 mA from a 500-100 current shunt

Application: Use a 500-100 (500A, 100 mV) current shunt. Digitally transmit the DC current
reading in amps with 0.1A resolution. Also transmit a 4-20 mA signal corresponding to 0-200A.

Input+D|spIa_1.:| Scaling T Filter T Relay AIarmsTEummunicatian Analog Dut 1

(& BASIC Option Sig Cond Option
C EXTENDED Boards [ -]

-Signal Input
- Mode Range r Custom Curye Rate 50;’5‘0 Hz Line FI“E{]
{ocv =] “ 0.2v |=]/[||pisabled ]ﬁ sabled =] ﬁsouz j—‘
- Display
r Resolution r Decimal Point Auto Tare
[+.5Digits =] |dddd . d ;"]Diﬁhhd |
Input+Display|  Scaling |  Filter | Relay Alarms | Communication| Analog Out |
-Scaling
~Scale ~ Offset
@®iscale, Offset > | +.50000 ‘ | +0000.0 |
@® Coordinates > |rLowIn rLow Read High In High Read —
C Reading Coord> | +.00000 ‘ ‘ +0000.0 | ’7‘ +.10000 | ’7‘ +0500.0 ‘

Input+DispIayT Scaling T Filter T Relay AIalmsTEummunicatiurT Ana

Ot |

Analog Out
|7"Anilog Out50uroe”'Lo Range Reading "R,anpei "Himmge Re.ading‘

‘ +0000.0 ‘ | I4-2l)mACurrent j +0200.0

|Unfi|tered j

Solution:

Jumper signal conditioner for +200.00 mV range.

Under “Input+Display” tab, set “Option Board” to DC, Mode to DC V, Range to 0.2V,
“Decimal Point” to dddd.d, and noise rejection to “50/60 Hz Line Freq.”

Under Scaling tab, if Coordinates is selected, set “High In” to 0.1V and “High Read” to
500.0A. For this application, Coordinates is the easiest, most intuitive scaling method.

Under Scaling tab, if “Scale, Offset” method is selected, set Scale to 0.5. The reason is that
a 200 mV full-scale input corresponds to 20,000 input counts, where each input count is
10 pV (as for the 200 mV scale of a 4-digit meter). These 20,000 input counts need to
correspond to 10,000 output counts, where each output count is 0.1A.

Under “Analog Out” tab, set Range to “4-20 mA current”, “Lo Range Reading” to 0.0A, and

“Hi Range Reading” to 200.0A.
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| 10. AC RMS SIGNAL CONDITIONER BOARD I

Five RMS voltage and four RMS current ranges are jumper selectable, as is AC or DC coupling. All
signal ranges are factory calibrated with calibration factors stored in EEPROM on the signal condi-
tioner board. Instrument Setup Software recognizes the board and brings up the appropriate menu
items for it; however, it does not recognize the jumper settings. Ranges also have to be entered
manually.

Board Revision S

Voltage Ranges Jumpers
200.00 mV j
2.0000V c,g,h
20.000 V C, i
200.00V c, k
300.0V & 600.0 V c, m

Current Ranges Jumpers
2.0000 mA l, k
20.000 mA b, m
200.00 mA a,m
5.000 A c,d,e,m

Signal Coupling Jumpers
AC +DC f The flexible noise shield may be removed for
AC only hone jumper setting, but must then be reinstalled.

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an unused jumper post.
3. OK o remove the plug-in shield for jumper setting, but reinstall before closing the case.

To minimize noise pickup, the input signal wiring should utilize a shielded twisted pair, and the
shield should be connected to signal low at the rms board, as illustrated below. If signal low is
close to earth ground, such as within 2V, signal low can further be connected to earth ground.

. . Sig High  RMS
|
Signal Source T-| Sig Low  Board

Shield around twisted pair

— Earth Ground
Shielding for AC noise reduction
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Example: Transmit the digital reading in amps and as 4-20 mA from an AC current transformer

Application: Use a 200:5 (200A in, 5A out) AC current transformer. Digitally transmit the AC
current reading in amps with 0.1A resolution. Also transmit a 4-20 mA signal corresponding to

0-100A.
Input+D|spIajE| Scaling T Filter T Relay AIalmsTEnmmunicaliorT Analog Out ]
(& BASIC Option Sig Cond Option
(“' EXTENDED BOZI’dS ITI'IJE RMS "I
- Signal Input
- Mode Range r Custom Curve Rate 50/60 Hz Line Freq
[RMS A | “ 5.0 | ||| pisabled j_‘“nisabled =] IVIEOHZ j—‘
-Display
— Resolution r Decimal Point Auto Tare
[4.5Digits ¥} [dddd . d j—‘“msahled |
Input+DispIayI Scaling T Filter T Relay Alarmsz Tl:nmmunicaliori/ Analog Out ]
-Scaling
r Scale r Offset
@ iScaie, Offset > | +.40000 | ‘ +0000.0 ‘
® Coordinates > |LowIn rLow Read High In High Read
O)IReading Coord> | +00 . 000 | ‘ +0000.0 | “ +05. 000 ‘ “ +0200.0 |
Input+DispIayT Scaling T Filter T Relay Alarmsz Tl:nmmunicaliori/ Ana uI: I
Analog Out
Analog Out Source |~ Lo Range Reading ~ Range ——— — Hi Range Reading
“Unfiltered =] } ’7‘ +0000.0 | ‘ “4-20:11.& Current ¥| ’7 +0100.0 ‘
Solution:

Jumper signal conditioner for 5.000 A current range and AC coupling.

Under “Input+Display” tab, set “Option Board” to True RMS, Mode to RMS A, Range to
9.0A, “Decimal Point” to dddd.d, and “50/60 Hz Line Freq” to 60 Hz to reject 60 Hz noise.

Under Scaling tab, if Coordinates is selected, set “High In” to 5.000A and “High Read” to
200.0A. For this application, Coordinates is the easiest, most intuitive scaling method.

Under Scaling tab, if “Scale, Offset” method is selected, set Scale to 0.4. The reason is that
a 95A full-scale input corresponds to 5,000 input counts, where each input count is
1 mA (as for the 5A scale of a 4-digit meter). These 5,000 input counts need to correspond
to 2,000 output counts, where each output count is 0.1A.

Under “Analog Out” tab, set Range to “4-20 mA current”, “Lo Range Reading” to 0.0A, and
“Hi Range Reading” to 100.0A.
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| 11. LOAD CELL & MICROVOLT SIGNAL CONDITIONER BOARD I

The load cell signal conditioner board offers sensitivity to +£20 mV full-scale and 4 or 6-wire
load cell connection. This board needs to be configured via jumpers for the desired full-scale
voltage range. All ranges are factory calibrated with calibration factors stored in EEPROM.
Instrument Setup Software recognizes the board and will bring up the appropriate menu items
for it; however, it does not recognize the jumper settings. The ranges also have to be selected
in Instrument Setup software. The excitation output can be set to 5V @ 100 mA, 10V @ 120
mA, or 24V @ 50 mA via main board jumper settings. Please see Section 14 of this manual.
Operation is ratiometric, with automatic compensation for changes in excitation voltage.

For DC microvolt applications, a scale factor of 1 and an offset of 0 are used for direct read-
ings in microvolts or millivolts. Decimal point selection does not affect the displayed digits. For
example, 20 mV can be transmitted as 20.000 mV or 20000 pV. The decimal point is set
separately.

For load cell applications, three scaling methods can be selected in Instrument Setup
Software: 1) Scale and offset, 2) Coordinates of 2 points, and 3) Reading coordinates of 2
points, which uses actual signals. Only menu items applicable to the selected scaling method
will be presented.

Load Cell & Microvolt Ranges

FS Input Jumpers | FS Counts
+20.000 mV e +20000
+50.000 mV a +50000 1]
+100.00 mV b +10000 1]
+250.00 mV c +25000
+500.00 mV d +50000 ]

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an unused jumper post.
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Example: Transmit weight in decimal tons and as 4-20 mA with overweight alarming

Application: Digitally transmit weight in metric tons with 3 decimal places using a 3 mV/V load
cell. Also output weight from 0 to 5.000 tons as a 0-10V signal. Apply 10V excitation. At a load
of 5.000 tons, the load cell output will be 30 mV. Alarm weight over 4.000 tons, but wait for 8
readings over this limit (or 15 msec) so as not to alarm on a noise spike.

Input+D|spIayE| Scaling T Filter T Relay Alalms]/l:ummunicaliuri/ Analog Out ]

® BASIC . Sig Cond Option
Option
C EXTENDED Bgards |Load Cell v|

-Signal Input

—Mode Range —Lustom Lurye Hate 50]’50 Hz Line Freq

[strain | “ 50.0mV =] ||| pisabled J—‘“ sabled ] hsouz j—‘
-Display

r Resolution r Decimal Point Auto Tare

[+.5Digits =] [dd . ddd j_‘ ’]Disahled |
Input+DispIayI Scaling T Filter TFlelayhlalms]/[:ummunicatiurq/ Analog I]ul]
-Scaling

rscale r Offset

@Scale, Offset > ||| +.16667 | ||| +00.000 |

(® Coordinates > |LowIn - Low Read High In High Read

C) Reading Coord> | +00 . 000 ‘ ‘ +00 . 000 | ’7‘ +30.000 | ’7‘ +05 . 000 ‘

Input+DispIa_l,lT Scaling T Filter T Relay Alarms]/l:ummunicatinri/ ‘Analog Out I

Analog Out
Analog Out Source - Lo Range Reading ~ Range——— —Hi Range Reading
’]Unfiltered j‘HV‘ +00.000 | "]D-lWVoltage j ’7 +05.000 ‘

Solution:

Jumper signal conditioner for 50.000 mV range. Set power supply to 10V excitation.

Under “Input+Display” tab, set Mode to Strain, range to 50.0mV, decimal point to 3 places,
and “50/60 Hz Line Freq” to 60 Hz to reject 60 Hz noise.

Under Scaling tab, if “Scale, Offset” method is selected, set Scale to 0.16667. The reason is
that we want 30000 input counts to correspond to 5000 output counts.

Under Scaling tab, if Coordinates is selected, set “High In” to 30.000 mV and “High Read”
to 5.000 tons.

Under “Relay Alarms” tab, enter 4.000 tons for Setpoint 1 and 8 readings to alarm.

Under “Analog Out” tab, set Range to “0-10V Voltage”, “Lo Range Reading” to 0.000 tons
and “Hi Range Reading” to 5.000 tons.
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| 12. THERMOCOUPLE SIGNAL CONDITIONER BOARD I

The thermocouple signal conditioner board can be configured via jumpers for either type J, K,
E, N thermocouples or type T, R, S thermocouples, and for upscale or downscale open sensor
indication. Instrument Setup Software recognizes the thermocouple board and will bring up the
appropriate menu items for it; however, it does not recognize jumper settings. For each jumper
selection, the thermocouple type, display in °C or °F, and resolution of 1°, 0.1° or 0.01° are
software selectable. High resolution should only be used for relative readings, not absolute
readings. Although available, 0.01° resolution is not recommended for thermocouples. Offset
adjustment is available for thermocouples and is normally set to 0000.0. If °C is selected,
entering an offset of 0273.2 will change the reading to Kelvin. If °F is selected, entering an
offset of 0459.7 will change the reading to Rankin.

Board Revision A PNP transistor

Thermocouple Type E4 Jumper 15-X c+b
J,K,E,N none
RS J J5-Y
Open T/C Indication E3 Jumper ca
Upscale h reTs
Downscale i =
I

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an unused jumper post.

The largest source of thermocouple reading errors are variations in the alloys used in
commercial thermocouple wires. Shown below are the American Limits of Error ASTM E230-
ANSI MC 96.1. These are the error limits imposed on manufacturers of thermocouple wire, not
error limits applicable to an instrument used with ideal thermocouple wire. The “Special Limit
of Error” applies to more expensive “Special Limits of Error” (SLE) thermocouple wire.

Thermocouple| Temperature Temperature Standard Limit Special Limit
Type Range °C Range °F of Error of Error

J 0 to 750°C 32 t01382°F 2.2°Cor0.75% | 1.1°Cor0.4%

K 0 to 1250°C 32 to 2282°F 2.2°Cor0.75% | 1.1°Cor0.4%

T 0 to 350°C 32 to 662°F 1.0°C or 0.75% | 0.5°C or 0.4%

E 0 to 900°C 32 to 1652°F 1.7°C or 0.5% 1.0°C or 0.4%

N 0 to 1300°C 32 to 2372°F 2.2°Cor0.75% | 1.1°Cor0.4%
SorR 0 to 1450°C 32 t0 2642°F 1.5°Cor 0.25% | 0.6°C or 0.1%
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Example: Transmit temperature, control a chiller, and provide an over-temperature alarm.

Application: Transmit temperature of a fermentation tank as a 4-20 mA signal from 15°C to
35°C. Turn on a chiller when the temperature reaches 28°C. Turn off the chiller when the tem-
perature is below 24°C. Alarm temperatures over 30°C. The sensor is a Type K thermocouple.

|nput+Disp|a_l'lT Scaling T Filter T Relay AIalmsTEnmmunicaliorT Analog Out ]

@ BASIC Option Sig Cond Option
) EXTENDED Boards |TC0"|V "l
-Signal Input
rMode Range rCustom Lurye Rate ———— —~ 50/60 Hz Line Freq
|Thermocouplej ’]Kdeg C j I sabled J_H] sabled j IVIE-I) Hz j—‘
- Display
r Resolution —Decimal Point Auto Tare
m |:::: i ]“Diﬂhl&d ﬂ
Input+DispIayT Scaling T Filter T HelayAlarmss]/EnmmumcallorT Analog Out ]
~Alarm 1 ~Alarm 2
rSetpoint 1 Setpoint 2
|W‘ |W‘
r Deviation 1 r Deviation 2
[ +000sa.0 ] [ +0000.0 ]
r Alarm State 1 r Alarm State 2
| Active High ||| ||| Active High =]
r Relayl Alrm State — r Relay2 Alrm State —
| Active On =l ||| active on =]
r Deviation 1 Type — r Deviation 2 Type —
I Span Hysteresis j I Span Hysteresis j
rAlarm 1 Type rAlarm 2 Type
| Hon-Latching  *||| ||| won-Latching  ¥|
Alarms 1,2 No. Rdgs to Alarm [ Filtered Alarm Source
’7| 64 Readings j—‘

Solution:

e Jumper signal conditioner for Type K thermocouple.

e Under “Input+Display” tab, set Mode to Thermocouple, range to “K deg C”, Resolution to
0.1 deg, and “50/60 Hz Line Freq” to 60 Hz to reject 60 Hz noise.

e Under “Relay Alarms” tab, select “Span Hysteresis” with a setpoint of 28.0°C and a devia-
tion of 4°C for Alarm 1, which will control the chiller. Select a setpoint of 30.0°C for Alarm

2, which will be used to alarm over-temperatures.
e Under “Analog Out” tab, set Range to “4-20mA Current”, “Lo Range Reading” to 15.0°C and
“Hi Range Reading” to 35.0°C.
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| 13. RTD & OHMS SIGNAL CONDITIONER BOARD I

The same signal conditioner board can be configured via jumpers for four RTD types (DIN
100Q platinum, ANSI 100Q platinum, 120Q nickel, 10Q copper) or for five resistance ranges
(from 20.000QQ to 200.00 kQ). Fixed 2Q or 2 MQ resistance ranges can be provided by a
factory modified signal conditioner board.

All ranges are factory calibrated with calibration factors stored in EEPROM on the signal condi-
tioner board. Instrument Setup Software recognizes the board and will bring up the appropriate
menu items for it; however, it does not recognize the jumper settings. Items to be entered in
Instrument Setup Software for the input side include Mode (RTD or Ohms), Range (RTD type
or ohms range), and Scale and Offset (a calibration correction applied to resistance).

Standard Board Modified Board | E1 Jumper

Cu10, 20.000Q 0-2.0000 Q b E1 |e E ~
0 - 200.00Q N/A c R
0-2.0000kQ | N/A d E2

0 - 20.000 kQ N/A e

0-200.00 kQ 0-2.0000MQ |f

Connection for RTD or Resistance E2 Jumper

2 or4 wire none

3 wire g

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an unused jumper post.

RTD and resistance measurement allow 2-, 3- or 4-wire hookup to compensate for lead wire
resistance. Please see Section 6 for hookup diagrams.

e In 2-wire hookup, the transmitter senses the voltage drop across the load and both lead
wires. The effect of the lead wires can be measured and subtracted by shorting out the load
during transmitter setup, as prompted by Instrument Setup software. The short should be as
close as possible to the load. Ambient temperature changes will still cause some error in the
readings -- the higher the lead resistance, the greater the error.

e In 3-wire hookup, the transmitter automatically compensates for lead resistance by mea-
suring the voltage drop in one current-carrying lead and assuming that the voltage drop in
the other current-carrying lead is the same.

e In 4-wire hookup, there is no lead wire resistance error, as different pairs of wires are used
for excitation and sensing. The sense wires only carry a few picoamperes and hence can
measure the voltage across the RTD without error.
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Example: Control incubator temperature, alarm over-temperatures, record on chart recorder

Application: Using an ANSI Platinum RTD as the sensor, control a heater to maintain the tem-
perature of an incubator at 99.0+0.5°F. Use 4-wire connection. Output temperature to an analog
chart recorder so that 0V = 95°F and 10V = 105°F. Alarm temperatures of 102°F or higher.

Input+Display |

Scaling

| Filter

T Relay AIarmsTEnmmunicaliurT Analog Out ]

® BASIC

on
O EXTENDED Boards

Sig Cond Option
|RTD!Dhm5 'l

- Signal Input

rMode Range Custom Curve Rate ——— ~ 50/60 Hz Line Freq
[rTD “M&Idegr =] ||| pisabled J—‘“ sabled =] hrrouz j—‘
-Display
r Resolution r Decimal Point Auto Tare
[0.1Deg 7] [addd.a  +] ’]Disahled =]
Input Connections

~ Relayl Alrm State —

~ Relay2 Alrm State —

| Active On

=

| Active On |

r Deviation 1 Type ——

r Deviation 2 Type ——

I Split Hysteresis j

| Band Deviation x|

rAlarm 1 Type

rAlarm 2 Type

| Non-Latching

—

| Non-Latching =]

I 16 Readings

"AIarms 1,2 Mo. Rdgs to Alarm

]

Input+DispIayT Scaling T Filter T HelaﬂyAla[mg]/[:ummumcatmri/ Analog Dut 1
rAlarm 1 rAlarm 2
r Setpoint 1 r Setpoint 2
+0089.0 +0102.0
r Deviation 1 r Deviation 2
+0000.5 +0000.0
rAlarm State 1 rAlarm State 2
| Active High =|I| ||| Active High |

[~ Filtered Alarm Source

Solution:

Jumper signal conditioner for Pt100 and 2 or 4-wire connection.

Under “Input+Display” tab, set Mode to RTD, Range to “ANSI deg F”, Resolution to 0.1 deg,
and “50/60 Hz Line Freq” to 60 Hz to reject 60 Hz noise.

Under “Relay Alarms” tab, select “Split Hysteresis” with a setpoint of 99.0°F and a deviation
of 0.5°F for Alarm 1, which will control the heater. Select a setpoint of 102.0°F for Alarm 2,

which will be used to alarm over-temperatures.
Under “Analog Out” tab, set Range to “0-10V Voltage”, “Lo Range Reading” to 95.0°F and
“Hi Range Reading” to 105.0°F.
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| 14. MAIN BOARD JUMPER SETTINGS I

7N\
@ OISO QIS [P
ede eCe ebelnm
5 E4 b
[ ]
b 1
[ |
° E1 E3 eCebeam |l
maebe
edecCe
Jd1 2 3
D
&, SIS RIS Bllble| &
Serial Signal Duplex Jumpers Termination Resistor*
Full None E6 a = Transmit, E6 ¢ = Receive
RS485
Half E6b+d** E6 ¢
RS232 Full None None

* The termination resistor jumper settings should only be selected if the transmitter is the last
device on an RS485 line longer than 200 feet (60 m).
**  0r connect external BTX to BRX and ATX to ARX (same effect as internal jumpers).

To reset communications to 9600 baud, command mode, Custom ASCII protocol, and Address 1,
place a jumper at E1, turn power on and off, remove the jumper, and restart the transmitter.

Analog Output J4 Pins Jumpers Excitation OQutput Jumpers
Current, 4-20 mA 1 Lo, 2 Hi E2a+d 5V, 100 mA E3a+c;E4a
Voltage, 0-10V 1 Lo, 2 Hi E2b+c 10V, 120 mA E3a+c;E4Db
Voltage, -10V to +10V 3 Lo, 2 Hi E2b+c 24V, 50 mA E3 b, E4 none

Notes: 1. Jumper settings are for main board Rev L.
2. Attempting to draw more than rated excitation output current will shut down the output.

3. The analog output is sourcing. Do not apply an external voltage. Applying an external
voltage of 24 Vdc will burn out the transmitter main board.
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| 15. DUAL RELAY OPERATION I

Dual AC/DC solid state relays rated 120 mA are standard for alarm or setpoint control and are
independently set up via the “Relay Alarms” tab of Instrument Setup Software. For online help

with any data entry field, press the F1 key.

|npul+DispIa_l,lT Scaling T Filter T FI ssT CommunicatiunT Analog Out ]

rAlarm 1 ~Alarm 2
r Setpoint 1 r Setpoint 2
[ +0100.00 | [ +020.000 |
r Deviation 1 r Deviation 2
[ +0000.00 | | +000.000 |
rAlarm 1 Source rAlarm 2 Source
IItem 1 j IItem 3 j
rAlarm 1 State rAlarm 2 State
| Active High =l ||| Active Low |

rRelayl Alrm State
| Active On (| || Active off |
r Deviation 2 Type

r Relay2 Alrm State

rDeviation 1 Type
I Band Deviation j I Split Hysteresis j
rAlarm 1 Type rAlarm 2 Type
I Non-Latching j I Latching j

I 4 Readings j

"Alarms 1.2 No.Rdgs to Alarm—‘

e Setpoint. The number to which the current reading is compared if deviation is set to zero. The
reading is the count in engineering units that is transmitted digitally and is also used for analog
output. For example, if the transmitted reading is in gallons/minute, the setpoint will be
referenced to that reading, not to the raw pulse rate sent from a turbine flow meter.

Set ointm i AFF\
1000 p 10 Setpoint

0
(@] (@]
£ £
E E
o OFF OFF o ON ON
02 42
s s
2 >
& 0
Time Time
“Active High” On/0ff setpoint control “Active Low” On/Off setpoint control
with deviation =0 with deviation = 0

-28 -



Deviation. A positive number that can be added or subtracted from the setpoint, depending on
the Deviation Type, to determine when an alarm becomes Active or Inactive.

Alarm Source. Depending on the Signal Input Mode and Function selected under the Input+
Display tab, the alarm can be assigned to any of up to three Items, for example to ltem 1
(A rate / B rate), Item 2 (A rate), or Item 3 (B rate).

Alarm State. If “Active High” is selected, the Active Alarm State is defined as being above the
setpoint. If “Active Low” is selected, the Active Alarm State is defined as being below the
setpoint. If “Disabled” is selected, the Alarm State is always inactive.

Relay State. A setting with ties the Relay State to the Alarm State. If “Active On” is selected,
the relay will be closed when the Alarm State is 1. If “Active Off” is selected, the relay will be
open when the Alarm State is 1.

Deviation Type. Three choices are offered: Split Hysteresis, Span Hysteresis, and Band
Deviation. These define how Setpoint and Deviation are to be combined to set Alarm State.

Heater . o
OFF OFF OFF Fail o % e
1050 - 1050 . (-
950 - - / o50l—e° oo %
2 Setpoint = 1000 £ e Setpoint = 1000
T Deviation = 50 ® Deviation = 50
g Hysteresis band = 100 & Pass band = 100
Time Time
Span Hysteresis for heater control Band Deviation for component testing

In Split Hysteresis, the relay opens (or closes) when the reading goes above the Setpoint plus
one Deviation, and closes (or opens) when the reading falls below the Setpoint less one
Deviation. Two Deviation limits lie symmetrically around the Setpoint to create a deviation
band. A narrow hysteresis band is often used to minimize relay chatter. A wide band can be
used for on-off control.

In Span Hysteresis, operation is as for Split Hysteresis, except that the Setpoint is always on
the high side, and a single Deviation lies below the Setpoint to create the hysteresis band.
Span Hysteresis is considered by some to be more intuitive than Split Hysteresis.

In Band Deviation, the relay opens (or closes) when the reading falls within the deviation
band, and closes (or opens) when the reading falls outside. Two deviation limits lie symmetric-
ally around the setpoint to create the deviation band. Passbands around a setpoint are often
used for go-no-go component testing.
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Alarm Type. Selections are Non-Latching and Latching. Under Non-Latching, the relay is only
closed (or open) while the Alarm State is Active. Under Latching, the activated relay remains
closed (or opens) until reset regardless of the Alarm State. Resetting is normally achieved by
temporarily grounding one of the transmitter’s control inputs, which has been set to Function
Reset under the “Input+Display” tab.

Alarms 1,2 No. Rdgs to Alarm. Selections are binary steps from 1 to 128. This is the number
of consecutive alarm readings that must occur to create an Active alarm. Numbers higher than
2 provide some Alarm filtering so that 1 or 2 noisy readings do not cause an Active Alarm. The
Alarm becomes Inactive if one of the consecutive readings fails to be an Alarm reading. The
Alarm readings counter then resets to 0.
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| 16. INPUT SIGNAL FILTERING I

The Filter tab provides selections to minimize the effect time jitter and electrical noise which
can affect trigger points. In most cases, filtering is only available for Item 1 and is grayed out
for totalizing and stopwatch functions.

| |npul+DispIa_l,lT Scaling T F||te| T Relay Alarms T CommunicatiunT Analog Out ]

Filter ITtem 1
Time Constant Type Threshold PeakValley Filter
“ 1.6 Sec j_‘ “ Adaptive 7| “ Low Adaptive ~| “ Filtered j}

e Time Constant provides a moving average filter with the following eight equivalent RC time
constants: no filter, 0.1 sec, 0.2 sec, 0.4 sec, 0.8 sec, 1.6 sec, 3.2 sec, and 6.4 sec. The longer
time constants provide superior noise filtering at the expense of fast response time. Note that
filtering can also be accomplished by lengthening the Gate time under the Input+Display tab.

o Type allows selection of Adaptive or Conventional filtering. With Adaptive, the time constant is
changed dynamically so that the transmitter can respond rapidly to actual changes in signal
while filtering out random noise. The moving average filter is reset to the latest reading when
the accumulated difference between individual readings and the filtered reading exceeds a
Threshold. The accumulated difference is also reset to zero when the latest reading has a
different polarity than the filtered reading. With Conventional filtering, the adaptive feature is
disabled and the Time Constant does not change.

o Threshold allows selection of Low Adaptive or High Adaptive for the Adaptive filter selection.
Normally select Low. Select High if the signal has large spurious transients which should not
be considered as an actual change in signal.

o Peak/Valley Filter allows the peak (maximum) or valley (minimum) functions to be based on
Unfiltered or Filtered readings. Normally select Unfiltered. Select Filtered if you expect spurious
readings which you do not wish to capture.
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| 17. TRANSMITTER CALIBRATION I

All analog input and analog output ranges of the transmitter have been digitally calibrated at
the factory prior to shipment using calibration equipment certified to NIST standards.
Calibration constants are stored digitally in non-volatile memory in EEPROM on the signal
conditioner board and main board. This allows signal conditioner boards to be changed without
requiring transmitter recalibration.

If periodic recalibration is required, the transmitter may be returned to the factory or to any
authorized distributor. A modest fee will apply, which also covers a Calibration Certificate.

DC, load cell, AC RMS, and thermocouple signal conditioner boards can be calibrated using
Instrument Setup Software running on a host PC, which is connected to the transmitter via
RS232 or RS485. The Calibration screen of Instrument Setup Software is accessed by clicking
on Calibration at the top of the DPM Main Menu screen. The PC first recognizes the type of
board, then prompts you to apply specific jumpers and specific known signals for each range.
Press Repeat to take more readings. When you have decided on which reading to accept, press
on the number 1 through 10 of that reading.

The RTD/Ohms signal conditioner board cannot be calibrated using the Calibration screen of
Instrument Setup Software. Instead, use the Scaling tab under Setup. Here you can enter
values for Scale and Offset for a specific range. These corrections apply to resistance, not to
RTD temperature. To calibrate RTD temperature, refer to the published resistance table for your
RTD type, and calibrate resistance. For example, if your measured resistances are 0.1% low,
apply a scale factor of 1.01.
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| 18. CUSTOM CURVE LINEARIZATION I

Curve.exe is a DOS-based, executable PC program used to set up an Extended transmitter so
that the internal digital readings have a user-defined, non-linear relationship with the input
signal. For example, it allows a transmitter to correct for transducer nonlinearity. Calculated
linearizing parameters are downloaded from a PC into non-volatile memory of the transmitter.
The curve-fitting algorithm uses quadratic segments of varying length and curvature, and
includes diagnostics to estimate curve fitting errors. The program is self-prompting, avoiding
the need for detailed printed instructions.

To get started, download curve.exe from our website into the directory that will also contain
your data files, such as ¢:\curves. Connect your transmitter to the PC and double-click on
curve.exe, which is an executable file. Follow the computer prompts and extensive help
information. Pressing R (Enter) returns to the main menu. You will be given the choice of four
data entry modes, which are explained in detail:

1) Text file entry mode

2) 2-coordinate keyboard entry mode
3) 2-coordinate file entry mode

4) Equation entry mode

-33-



| 19. MODBUS PROTOCOL TRANSMITTER COMMUNICATIONS I

1.0 GENERAL

The Modbus capability conforms to the Modbus over Serial Line Specification & Implemen-
tation guide, V1.0. Both the Modbus RTU and Modbus ASCII protocols are implemented. This
5-page manual section presents key programmable Modbus features. Our detailed Modbus
manual can be downloaded from http://www.laurels.com/downloadfiles/modbus.pdf

Modbus RTU

Baud Rate........... 300, 600, 1200, 2400, 4800, 9600 or 19200
Data Format ....... 1 start bit, 8 data bits, 1 parity bit, 1 stop bit (11 bits total)

Parity......cc.cooue.... None, Odd, Even (if None, then 2 Stop bits for 11 total)
Address.............. 0 for broadcast, 1-247 for individual meters
Modbus ASCII

Baud Rate........... 300, 600, 1200, 2400, 4800, 9600 or 19200
Data Format ....... 1 Start bit, 7 Data bits, 1 Parity bit, 1 Stop bit (10 bits total)

Parity......c..coe.... None, Odd, Even (if None, then 2 Stop bits for 10 total)
Address.............. 0 for broadcast, 1-247 for individual meters
2.0 FRAMING

Modbus RTU: Message frames are separated by a silent interval of at least 3.5 character times.
If a silent interval of more than 1.5 character times occurs between two characters of the
message frame, the message frame is considered incomplete and is discarded. Frame Check =
16 bit CRC of the complete message excluding CRC characters.

Modbus ASCII: The message begins immediately following a colon (:) and ends just before a
Carriage Return/ Line Feed (CRLF). All message characters are hexadecimal 0-9, A-F (ASCII
coded). The system allowable time interval between characters may be set to 1, 3, 5 or 10
seconds. Frame Check = 1 byte (2 hexadecimal characters) LRC of the message excluding the
initial colon (:) and trailing LRC and CRLF characters.

3.0 ELECTRICAL INTERFACE

RS232, two-wire half-duplex RS485, or four-wire full-duplex RS485 signal levels are selectable
via jumpers on the transmitter main board and a the connector. Please see Section 13. The
RS485 selection provides a jumper selection for insertion of a line termination resistor. In case
of a long line (greater then 500 ft) to the first device, a termination resistor should be selected
for the first device. In case of a long line between the first and last devices, a termination
resistor should be selected for the first and last devices. Never add termination resistors to
more than two devices on the same line.
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4.0 COMMUNICATIONS SETUP
Parameters selectable via downloaded Instrument Setup software:

Serial Protocol .........cccceeveuveuennee, Custom ASCII, Modbus RTU, Modbus ASCI|
Modbus ASCII Gap Timeout........... 1 sec, 3 sec, 5 sec, 10 sec

Baud Rate........ccccevveeveeeeeeeee, 300, 600, 1200, 2400, 4800, 9600, 19200
Parity ..coeeveeeeeeeeeeeee e No parity, odd parity, even parity

Device AAress ......ccoceeveeeeeeeenene, 0 to 247

5.0 SUPPORTED FUNCTION CODES

FC03: Read Holding Registers
Reads internal registers containing setup parameters (Scale, Offset, Setpoints, etc.)

FC10: Write Multiple Registers (FC10 = 16 dec)
Writes internal registers containing setup parameters (Scale, Offset, Setpoints, etc.)

FC04: Read Input Registers

Reads measurement values and alarm status. Returns values in 2's Complement Binary Hex
format without a decimal point. The displayed system decimal point can be read with FCO3 at
address 0057. Use only odd Register Addresses and an even number of Registers.

Register

Address TM Transmitter Response

00 01 Returns Hi word of Alarm status

00 02 Returns Lo word of Alarm status

0003 Returns Hi word of Measurement value
00 04 Returns Lo word of Measurement value
00 05 Returns Hi word of Peak value

00 06 Returns Lo word of Peak value

00 07 Returns Hi word of Valley value

00 08 Returns Lo word of Valley value

FCO05: Write Single Coil
Action command to meter

Output Output

Address Value Action Command

00 01 FF 00 Transmitter Reset (No Response)

00 02 FF 00 Function Reset (Peak, Valley)

00 03 FF 00 Latched Alarm Reset

00 04 FF 00 Peak Reset

00 05 FF 00 Valley Reset

000C FF 00 Tare Command (Weight Transmitter) (00 00 resets Tare)
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FCO08: Diagnostics
Checks communications between the Master and Slave, and returns the count in the Modbus
Slave counters (which are reset when the meter is reset).

el Data | Response
Function p Description
Send Data

Code

00 00 Any Same [Returns Query Data (N x 2 bytes). Echo Request.

as sent

00 01 Restarts Communications. If in the Listen-Only mode, no
response occurs. Takes Slave out of the Listen-Only mode
and one of the following:

FF 00 FF00 [Clears communications event counters.
00 00 00 00 |Does not clear communications event counters.

00 04 00 00 None |Forces Listen-Only. All addressed and broadcast
Messages are monitored and counters are incremented,
but no action is taken or response sent. Only Sub-
Function 00 01 causes removal of this Listen-Only state.

00 0A 0000 00 00 |Clears all Modbus slave counters.

00 0B 00 00 Total Returns total number of messages detected on the bus,

Message |including those not addressed to this Slave. Excludes bad
Count [LRC/CRC, parity error or length < 3.
00 0C 00 00 | Checksum [Returns total number of messages with bad LRC/ CRC,
Error | parity or length < 3 errors detected on the bus including
Count [those not addressed to the Slave.
000D 00 00 | Exception |Returns total number of Exception responses returned by
Error  |the Addressed Slave or that would have been returned if
Count |not a broadcast message or if the Slave was not in a
Listen-Only mode.
00 OE 0000 Slave | Returns total number of messages, either broadcast or
Message |addressed to the Slave. Excludes bad LRC/CRC, parity or
Count |[length < 3 errors.
00 OF 0000 No Returns total number of messages, either broadcast or
Response |addressed to the Slave, for which Slave has returned No
Count |Response, neither a normal response nor an exception
response. Excludes bad LRC/CRC, parity or length < 3
errors.
00 11 0000 Slave | Returns total number of Exception Code 6 (Slave Busy)
Busy [responses.
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6.0 SUPPORTED EXCEPTION RESPONSE CODES

Code Name

01 lllegal Function

02 lllegal Data Address
03 lllegal Data Value
04 Slave Device Failure

7.0 MESSAGE FORMATTING

MA = Meter Address

FC = Function Code

RA = Register Address
NR = Number of Registers
NB = Number of bytes

Modbus RTU Format

Error Description

lllegal Function Code for this Slave. Only hex Function
Codes 03, 04, 05, 08, 10 (dec 16) are allowed.

lllegal Register Address for this Slave.
lllegal data value or data length for the Modbus protocol.

Slave device failure (eg. Transmitter set for external gate).

DD = Data (Hex)

WW = Data (On/Off)

SF = Sub-Function
EC = Error Code
LRC = ASCII Checksum

CL = CRC Lo Byte
CH = CRC Hi Byte

CR = Carriage Return
LF = Line Feed

. >3.5 Byte Number
FC Action
! Char [ 1 |2 |34 ]5]|6]7]8]09]10]11
03 [Request NoTx |MA| FC | RA|RA|NR|NR| CL |CH
03 [Response NoTx |MA | FC | NB |DD*|DD*| CL | CH
04 |Request NoTx |MA| FC | RA|RA|NR|NR| CL |CH
04 |Response NoTx |MA | FC | NB |DD*|DD*| CL | CH
05 [Request NoTx |MA | FC | RA | RA |WW|WW| CL | CH
05 |[Response NoTx |MA| FC | RA | RA |WW|WW]| CL | CH
08 |Request NoTx |(MA | FC | SF | SF |WW|[WW | CL | CH
08 [Response NoTx |MA| FC | SF | SF | DD | DD | CL | CH
10 |Request NoTx |MA| FC | RA|RA | NR|NR | NB |DD*|DD*| CL | CH
10 [Response NoTx |[MA| FC | RA|RA|NR|[NR|CL |CH
Exception NoTx |MA | FC | EC | CL | CH
Response +80

DD* = (DD DD) times NR (Number of Registers)
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Modbus ASCII Format

Byte N
FC | Action yte Numher
2 | 34|56 (7|89 ([10]11(|12] 13
03 |Request MA| FC | RA|[RA [ NR [ NR [LRC| CR | LF
03 |Response MA| FC | NB |DD*|DD*|LRC| CR | LF
04 |Request MA| FC | RA| RA| NR [ NR |LRC| CR | LF
04 |Response MA| FC | NB |DD*|DD*|[LRC| CR | LF
05 |Request MA| FC | RA | RA [WW|[WW |[LRC| CR | LF
05 [Response MA| FC | RA | RA |WW|[WW|LRC| CR | LF
08 |Request MA| FC | SF | SF {[WW [WW [LRC| CR | LF
08 |Response MA| FC | SF | SF | DD | DD |LRC| CR | LF
10 |Request MA| FC | RA| RA| NR [ NR | NB |DD*|[DD*|LRC| CR | LF
10 |Response MA| FC | RA[RA [ NR [ NR [LRC| CR | LF
Exception MA | FC | EC |LRC| CR | LF
Response +80
DD* = (DD DD) times NR (Number of Registers)
8.0 MESSAGE EXAMPLES
All examples are for Transmitter Address = 01 and No Parity.
Modbus RTU Modbus ASCII
Ser_4 -> Action 010 020
Addr -> 001 001
Restart Com- | Request 010800010000B1CB :010800010000F6crlf
munications Response* 010800010000B1CB :010800010000F6crlf
Meter Reset Request 01050001FFOODDFA :01050001FFOOFAcrlf
Response None None
Digital Reading | Request 01040003000281CB :010400030002F6crlf
e Response 010404000009D67C4A :010404000009D618crlf
Write Setpoint | Request 0110000100020400000E743624 | :0110000100020400000E7466¢Tlf
1=+37.00"*" | Response 01030400000E74FE74 :011000010002ECcrlf
Read Setpoint | Request 01030001000295CB :010300010002F9crlf
1=+37.00"** | Response 01030400000E74FE74 :01030400000E7476crlf

* Suggested as first message after power-up. If transmitter is in Listen-Only mode, no response
is returned. ** Example while reading +25.18 *** Decimal point is ignored.

9.0 INTERNAL REGISTERS: Please refer to the full Modbus Protocol Communications Manual,
which is downloadable from our website.
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| 20. CUSTOM ASCIlI PROTOCOL TRANSMITTER COMMUNICATIONS I

1.0 SERIAL COMMUNICATION FORMAT

Mode ................ Full Duplex (Separate transmit and receive lines) and Half Duplex (RS485 only)

Baud Rate.......... 300, 600, 1200, 2400, 4800, 9600, 19200 selectable with Instrument Setup
software.

Parity ............... None

Word length...... 8 data bits

Stop bit ............ 1

The Custom ASCII protocol is simpler than the Modbus protocol. This 5-page manual section
provides some of its key programmable features. Our detailed Serial Communications manual
can be downloaded from http://www.laurels.com/downloadfiles/serialcom?2.pdf

2.0 MEASUREMENT DATA FORMAT

The basic measurement data format consists of 8 ASCII characters for analog input “DPM”
transmitters, such as +999.99<CR>, where <CR> is the carriage return character. The first
character is always a plus or minus sign. A decimal point is always furnished, even when it
follows the last digit.

Adding a Line Feed Character to the Basic Format: Printers and other devices that receive the
data may require a line feed character <LF> following the <CR>. The line feed character <LF>
may be selected using Instrument Setup software.

Adding a Coded Data Character to the Basic Format: A coded character from A to H may be
added to the data string according to the table below to indicate the alarm and overload status
of the device. If used, this character precedes the <CR>, so that it is the last printable character
in the string. With the optional <LF> and coded character selected, the data string will consist
of 10 characters for analog input “DPM” transmitters, such as +999.99A<CR><LF>.

Alarm Status No Overload Overload
Neither Alarm set A E
Alarm 1 set only B F
Alarm 2 set only C G
Both Alarms set D H

For example, a coded character “G” indicates that Alarm 2 only is set and that the transmitter is
in the overload condition. This information is useful when data is supplied to a computer for
listing and analysis, or when data is supplied to a Remote Display in a Master-Slave confi-
guration.
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Values are transmitted in a continuous string with no intervening spaces. If the 5th digit in is
set to 1 using Instrument Setup software, the termination characters of <CR> and optional
<LF> appear after each value. If the 5th digit is et to 0, the termination characters appear only
once at the end of the string. In either case, if included, the coded character appears at the end
of the last value only.

3.0 NETWORK CONFIGURATIONS

Using the Custom ASCII protocol, TM Series transmitters can operate in a point-to-point mode
using RS232 or RS485, or in a multi-point mode using RS485.

The point-to-point mode is a direct connection between a computer (or other digital device)
and the transmitter. Any device address can be selected; however, it is suggested that address
1 be selected as a standard for the point-to-point mode.

The multi-point mode is a connection from a host computer to a multiplicity of transmitters
bused together with their inputs and outputs connected in parallel. For long cable runs, the last
device should have a termination resistor installed. It is necessary to set up each device on the
bus with a different address from 1 to 31. To command a particular device, its address is used
in conjunction with the command, and only that device responds. The outputs of all of the
devices on the bus are set to a high impedance state, except the device being addressed. The
device addresses range from 1 to 31, with 0 being a special address to which a meter responds
only internally (e.g. Reset), but does not transmit any response on the output lines. All devices
may be commanded simultaneously with a 0 address, and there will not be any output
response contention. Addressing of transmitters can be set with Instrument Setup software.

4.0 COMMAND MODE OVERVIEW

Using the Custom ASCII protocol, TM Series transmitters operate in the Command Mode only.
In this mode, the device does not send data automatically, but responds to commands received
from a host computer. These commands can be:

e To transmit the latest or peak measurement

e To reset the meter completely or just the peak value and/or latched alarms
e To display a value sent from the computer

e To transmit present setup parameters

e To receive new setup parameters,

e To monitor or alter data in selected memory locations of the meter.

5.0 COMMAND MODE FORMAT
CHAR 1 - Command Identifier

All commands begin with “*” followed by the meter address, then a command letter
followed by a sub-command number or letter. Additional characters may be append-
ed. All commands terminate with <CR> (<LF> ignored).
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Char # Character

Description

*

0-V
A-Z
0-U

S~ wonND =

Command Identifier. Recognition Character.
Device Address. 0 addresses all devices, 1-V specific devices.

Command Function

Sub-command. Number of Bytes of RAM or Words (2 Bytes) of
non-volatile memory data being transferred.

CHAR 2 - Address Codes

A Serial Communications Address Code from 1 to V follows the

address number from 1 to 31.

xn

to indicate the device

Device # A((i:((l)rde:s Device # A((i:((i]rdeess Device # A:I:ctllrde:s
1 1 12 C 23 N
2 2 13 D 24 0
3 3 14 E 25 P
4 4 15 F 26 Q
) ) 16 G 27 R
6 6 17 H 28 S
7 7 18 I 29 T
8 8 19 J 30 U
9 9 20 K 31 V
10 A 21 L
11 B 22 M

CHARS 3 & 4 - Commands and Subcommands

The examples below use a default address of 1 following the “*“. Substitute the desired
address from the above table of Serial Comm Address Codes. All command sequences shown
must terminate with <CR>, followed by an optional <LF>.

Request DPM Values

Get reading™*
Peak reading
Valley reading

*1B1
*1B2
*1B3

** The meter transmits the value or values selected with Instrument Setup software.

Reset Functions, DPM Transmitter
*1C0 Reads NVMEM into RAM locations after RAM is zeroed.

Cold reset
Latched alarms reset

*1C2
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Peak value reset *1C3

Remote display reset *1C4
Valley reset *1C9
Tare function “1CA
Tare reset “1CB

6.0 READING AND WRITING TO RAM AND NONVOLATILE MEMORY

CHAR 1, 2: The Recognition character and Meter Address Code are the same as shown in
previous table.

CHAR 3: Command character:

Read bytes from RAM Memory

Write bytes to RAM Memory (DPM and Scale meter only)
Read bytes from Upper RAM Memory

Write bytes to Upper RAM Memory

Read words from Non-Volatile Memory

Write words to Non-Volatile Memory

CHAR 4: Command character. Sub-command. Number of Bytes of RAM or Words (2 Bytes) of
non-volatile memory data being transferred.

=SExX0omT®

Code # Number Code # Number Code # Number
1 1 B 11 L 21
2 2 C 12 M 22
3 3 D 13 N 23
4 4 E 14 0 24
5 5 F 15 P 25
6 6 G 16 Q 26
7 7 H 17 R 27
8 8 I 18 S 28
9 9 J 19 T 29
A 10 K 20 U 30

CHAR 5, 6: See tables for the RAM MEMORY ADDRESSES and NONVOLATILE MEMORY
ADDRESSES with their respective data definitions.
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General, Reading and Writing Ram Memory Data

RAM memory data is read and written as a continuous string of bytes consisting of 2 hex
characters (0-9,A-F) per byte. Included in the command are the total number of bytes to be
transferred and the most significant address in RAM of the continuous string of bytes. The
format is:

Read lower RAM data *1Gnaa
Write lower RAM data *1Fnaa<data>
Read upper RAM data *1Rnaa
Write upper RAM data *1Qnaa<data>

where: n is the number of bytes to be read or written.
aa is the most significant address in RAM of the bytes to be read
or written.
<data> is n bytes of 2 hex characters per byte in order from the most

to the least significant byte.
The number of bytes n consists of a single code character representing values from 1 to 30 as
shown above under CHARACTER 4. The most significant address aa consists of 2 hex charac-
ters as shown below under RAM MEMORY ADDRESSES AND DATA DEFINITIONS.

General, Reading and Writing Nonvolatile Memory Data

Nonvolatile data is read and written as a continuous string of words consisting of 2 bytes or 4
hex characters (0-9,A-F) per word. Included in the command is the total number of words to
be transferred and the most significant address in nonvolatile memory of the continuous string
of words. The format is:

Read nonvolatile memory data *1Xnaa (followed by Meter reset)
Write non-volatile memory data *1Whnaa <data> (followed by Meter reset)
where: n is the number of words to be read or written.
aa is the most significant address in nonvolatile memory of the words to be
read or written.
<data> is n words of 2 bytes or 4 hex characters per word in order from the most to

the least significant address.

The coded number of words n consists of a single character representing values from 1 to 30
as shown under CHARACTER 4. The most significant address aa consists of 2 hex characters
as shown under NONVOLATILE MEMORY ADDRESSES.
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| 21. LT SERIES ANALOG INPUT TRANSMITTER SPECIFICATIONS I

Mechanical

CaSe dIMENSIONS......cueiviiiiiieteceeeee ettt 120 x 101 x 22.5 mm

CaSE MOUNTING...cuveuiieicieciece e 35 mm DIN rail per EN 50022

Electrical CONNECHIONS .....c.eeieveeicieeee e, Detachable screw plug connectors
Environmental

Operating teMPEIATUIE ......c.ecveieeeeeeeeeeee ettt 0°C to 55°C

STOrage tEMPEIALUIE ........cveeeeeceeceeeeee et -40°C to 85°C

Relative humidity .........coooveieiiiieece e 95% from 0°C to 40°C, non-condensing
Power & Electrical

Power to Transmitter..........ccccooeveeeeiecnenneee, 85-264 Vac / 90-300 Vdc, or 12-32 Vac / 10-48 Vdc

Power Isolation....... 250 Vrms between power, signal input, analog output, relays, and serial I/0
Transmitter Setup

Selection of signal ranges & temperature sensors .............. Jumpers on signal conditioner board

Selection of serial format, excitation output, analog output..................... Jumpers on main board

Programming........cccceeveevveeeeceecneeneen, Via PC using Instrument Setup software and serial cable
Analog to Digital Conversion)

CONVErSion rate.........ccceeeeeeeeeeieeceeeeeeeeeeees 60/sec at 60 Hz power, 50/sec at 50 Hz power

[NPUL TESOIUTION ..o 16 bits (65,536 steps)
Analog Output (standard)

OULPUL LBVEIS ... 4-20 mA, 0-20 mA, 0-10V, -10V to +10V

Source of SinK.......ccoeveeeecicecee Sourcing. Do not connect to a load which applies a voltage.

Compliance at 20 MA......c.ooieiee e 10V (0 to 500Q load)

ComplianCe at 10V .......cuvieeeeee e 2 mA (5 kQ load or higher)

OUEPUL FESOIUTION ... 16 bits (65,536 steps)

Output accuracy........cccoeevveeerenenee. +0.02% of full span for DC inputs, +0.1% for AC RMS inputs
Serial 1/0 (standard)

Serial formats .......coovvevveieereee e RS232 or RS485 (half or full duplex), selectable

Serial Protocol .....ccooveeeeieieeeee e Custom ASCII or Modbus (RTU or ASCII)

Serial CoNNECION.........ccvieeeeeeeeee e, Detachable screw terminal plugs
Transducer Excitation OQutput (standard for DC, process, strain gauge, load cell inputs)

OULPUL ISOIALION ..o + 50 Vdc to meter ground

Selectable levels ................... 5Vdc + 5%, 100 mA; 10 Vdc = 5%, 120 mA; 24 Vdc + 5%, 50 mA
Dual Relay Output (standard)

Relay type .....ooveeceeeeceee e Two solid state relays, SPST, normally open, Form A

LOAd TatiNG oo 120 mA at 140 Vac or 180 Vdc



Input Signal Noise Rejection

CMV, DCE0 B0 HZ ...ttt ettt 250V RMS

CMRB, DC 10 B0 HZ....eee ettt eaeenas 130 dB

NMR at 50/60 HZ ...t 90 dB with no digital filtering

Input filering ........cooeeveeeeieeeeee Programmable digital time constants from 80 mst0 9.6 s
Overvoltage Protection

Voltage input ranges of 2V and above (AC 05 DC) .....covevveuveeeiieeeeecececee e, 600 Vrms

Voltage input ranges of 200 mV (AC or DC), load cell, thermocouple, RTD .................. 100 Vrms

DC Volts, DC Amps, Process and DC Ratio Input

Range Input Resistance Input Error
+200.00 mV 16GQ
+2.0000 V 1G6Q 0.01% of full scale
+20.000 V 10 MQ + 2 counts
+200.00 V 10 MQ
+300.0 V & +600.0 V* 10 MQ +04V
+2.0000 mA 100 Q
+£20.000 mA 100 0'01:/"2";;3:]';03'3
+200.00 mA 1Q -
+5.000 A 0.01Q +10 mA

True AC RMS Volts & Amps

Range Input Resistance Input Error
200.00 mV 1 MQ
2.0000V 1 MQ 0.03% of full scale
20.000 V 1 MQ + 2 counts
200.00V 1 MQ
300.0 V & 600.0 V* 1 MQ +0.8V
2.0000 mA 100 Q
0.000 mA 100 O.OS:/zogofSrI]It:cale
200.00 mA 1Q -
5.000 A 0.01Q +20 mA
COUPIING oo, AC or AC + DC (jumper selectable)
AC Frequency RANQe........ccevveveeceeeeececrecie e 10 Hz to 15 kHz, crest factor to 3.0

* 600V ranges are only ETL certified to 300V.
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Load Cell, Strain Gauge & Microvolt Input

Range 1 Count | Input Resistance Input Error
+20.000 mV v 0.01% of full scale + 2 counts
+50.000 mV Tpv for absolute voltage readings
+100.00 mV 10 pv 1GQ
+950.00 mV 10 pv 0.01% of reading + 2 counts
+500.00 mV 10 v for ratiometric bridge readings
RTD Input (1°, 0.1° or 0.01° resolution)
Type Excitation Range Conformity Error
Platinum, Pt100 956 LA -202 to 850°C 0.03°C
a =.00385 (DIN) H -331 to 1562°F 0.05°F
Platinum, Pt100 956 LA -202 to 631°C 0.04°C
a =.003925 (ANSI) H -331 to 1168°F 0.07°F
Nickel, Ni120 956 LA -80°C to +260°C +0.05°C
a =.00672 H -112°F to +500°F +0.09°F
Copper, Cu10 5.0 mA -97°C to +260°C +0.05°C
a =.00427 ' -143°F to +500°F +0.09°F
RTD CONMNBCLION: ..ttt ettt e et e e et e e e e e e s st e e s sbaeeseneeessnneneans 2,3 0r4 wire
] O LA 1] 1 o U +0.003% of reading/°C
W] (0 (<] 1110 [o] o OO OO +(0.03 deg/deg
Sensor lead resistance tempco per conductor, 2-wire.................... 10 udeg/ Q /degupto 10 Q
Sensor lead resistance tempco per conductor, 3 & 4-wire............ 10 pudeg / Q / deg up to 100 Q
OVEr-voltage ProteCLiON ......c.cveeeeececee e 125 Vac
Open sensor indication ............cccceeveeeeeeeeeeeeeeeenee 0 mA or > 20 mA output, jumper selectable
Thermocouple Input (1° or 0.1° resolution)
Selection of signal ranges & temperature SENSOrS ......cccccveeeveevecvenennee, Via jumpers and software
Selection of serial format, excitation output, analog output................ Via jumpers on main board
Programming.........ccccceeveeveeeieciecnenee, Via PC using Instrument Setup software and serial cable
INPUL TESISTANCE ...ttt ettt e ae et et e eee et 1G6GQ
OVerall iNPUL ACCUTACY ...veeveeeeeeeeeeeeie et + 0.01% of full span £2 counts
Max lead resiStancCe ..........coceevvevieiececececcece e 1 kQ max for rated accuracy
SPAN TBMPCO.....eeee ettt e ettt eeene e +0.003% of reading/°C
Reference junction teMPCO .......ouvioueeeieeceee e e +(0.02 deg/deg
OVEr-voltage ProteCHION ......c.oveeeeee ettt 125 Vac
Open sensor indication ...........cccceevevveveeiee e 0 mA or > 20 mA output, jumper selectable



Type Range Conformity Error
J -210 to 760°C 0.09°C
-347t0 1400°F 0.16°F
K -244 10 1372°C 0.10°C
-408to 2501°F 0.17°F
0 to 400°C 0.03°C
T -257 t0 0°C 0.20°C
32 to 752°F 0.05°F
-430 to 32°F 0.36°F
c -240 to 1000°C 0.18°C
-400 to 1830°F 0.32°F
N -245 10 1300°C 0.10°C
-410 to 2370°F 0.17°F
S -46 t0 +68°C 0.12°C
-51 to +213°F 0.22°F
R -45 10 1768°C 0.17°C
-49 t0 3214°F 0.31°F
Resistance Input
Range 1 Count Excitation Input Error
0-20.000 Q 1 mQ 5 mA
0-200.00 Q 10 mQ 500 pA
0-2000.0 Q 100 mQ 90 pA 0.01% of reading
0-20000 Q 10 5 pA + 2 counts
0-200.00 kQ 10Q 500 nA
0-2.0000 MQ* 100 Q 500 nA
* Factory special fixed range
L0 COMMEBCTION: ...ttt e e e e e e e e s st e e s sba e e s eneeesenneeeans 2,3 or4 wire
] O LA 1] 1 o U +0.003% of reading/°C
OVer-voltage ProteCHiON .......c.coveueeecece et 125 Vac
Open sensor indication ...........ccccceevevveveeiee e 0 mA or > 20 mA output, jumper selectable
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| 22. WARRANTY I

Laurel Electronics Inc. warrants its products against defects in materials or workmanship for a
period of one year from the date of purchase.

In the event of a defect during the warranty period, the defective unit may be returned to the
seller, which may be Laurel or a Laurel distributor. The seller may then repair or replace the
defective unit at its option. In the event of such a return, freight charges from the buyer shall be
paid by the buyer, and freight charges from the seller shall be paid by the seller.

LIMITATION OF WARRANTY

The foregoing warranty shall not apply to defects resulting from:
1. Improper installation or miswiring.
2. Improper or inadequate maintenance.
3. Unauthorized modification or misuse.
4. Operation outside the environmental specifications.
5. Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is
expressed or implied. Laurel specifically disclaims implied warranties of merchantability and
fitness for a particular purpose.

Any electronic product may fail or malfunction over time. To minimize risks associated with
reliance on Laurel products, users are expected to provide adequate system-level design and
operating safeguards. Laurel’s products are intended for general purpose industrial or
laboratory use. They are not intended nor certified for use in life-critical medical, nuclear, or
aerospace applications, or for use in hazardous locations.

EXCLUSIVE REMEDIES

The remedies provided herein are Buyer’s sole and exclusive remedies. In no event shall Laurel
be liable for direct, indirect, incidental or consequential damages (including loss of profits)
whether based on contract, tort, or any other legal theory.

Copyright 2009-2021, Laurel Electronics, LLC 17 December 2021
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